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Today's Agenda
1. Bookbinding Service at EPL
2. Set up Book Dimension

• Page Size
• Margins

3. Front and Back Matter
• Verso & Recto Pages
• Copyright Page

4. Formatting Manuscript
• Page Breaks vs Section Breaks
• Styles
• Table of Contents
• Fonts
• Alignment, Indentation & Spacing
• Running Headers
• Page Numbers
• Adding Images
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Bookbinding at EPL
• Machine-assisted, hands-on book making using Perfect 

Bind method
• Limit of 1 book per month and 5 copies per binding 

session
• Book size is limited to 5.5” x 8.5”

 50 pages minimum 
 700 pages maximum

• Cream internal pages printed in B&W only. 
 No full bleeds on internal pages

• Covers are printed in color one-side only
• Pricing is $0.05 per page + $1.00 for cover/bind before 

tax.
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Bookbinding at EPL
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Books you can make at EPL 

Novels

Family history/memoirs

Poetry

Short story collections

Anthologies

Recipe books

Books you cannot make at EPL 

Textbooks, e-books or books that 
are in copyright

Children's picture books

Photobooks

Repairing old spines

Books in sizes other than 5.5" x 
8.5"

Books with less than 50 pages or 
more than 700 pages



Book Dimensions
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If you are using 
Google Docs, you'll 
want to change the 
Page Setup to 
Statement size first!

Google Doc to Word
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File > Download > Microsoft Word

Since this guide is for 
MS Word, you'll have 
to download your file.



Page Size
• Match your document to your book size!
• At EPL our book size is 5.5” x 8.5”
• Layout > Size > Statement or

More Paper Sizes > Custom Sizes > 
enter 5.5 in (13.97 cm) & 8.5 in (21.59 cm)

• Make sure it’s applied to the Whole 
Document
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Page Size

8



Margins
• The minimum margins 

for your books should 
be 0.25 in (.64 cm)

• Recommend margins
at 0.5 in (1.27 cm)

• For books we want the 
pages set to Mirror 
Margins.
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Gutters
• Gutter is the inner margins of 

a bound book; adjacent inner 
margins of facing pages 
when book is open.

• In a bound book, some of 
this gap will appear as a 
margin, and some will 
disappear into the binding.

• Some binders add the gutter 
and inside margins together 
as one measurement.
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Gutters
• The more pages the book has, the 

bigger the gutter needs to be.
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Page Count Gutter Margin (min)
40 to 150 pages 0.125 in (3.2 mm)
151 to 300 pages 0.25 in (6.4 mm)
301 to 500 pages 0.375 in (9.6 mm)
501 to 700 pages 0.50 in (12.7 mm)
700 pages + 0.625 in (15.9 mm)

Adapted from Kindle Direct Publishing
https://kdp.amazon.com/en_US/help/topic/GVBQ3CMEQW3W2VL6



Front and Back Matter
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Verso & Recto
• Recto is the "right" or "front" (odd 

pages) and verso is the "left" or "back" 
side (even pages).

• Books always 
start on Page 1, 
the recto side.
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Common Front Matter
1. Half-title [bastard page]
2. Other books by (verso of the half-title)
3. Title Page
4. Copyright Page [colophon] (verso the title 

page)
5. Dedication
6. Table of Contents
7. Foreword and/or Preface
8. Lists of Tables and Figures
9. Lists of Contributors
10.Acknowledgements (sometimes at the back)
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Half-Title vs Title Page
• Half -Title has nothing but the book's 

title, though many books skip this page.
• Half-Title usually uses the same 

typesetting for the Title as the book's 
Cover.

• Title page includes:
• Book title (with the subtitle)
• Author’s name
• Publisher’s name and city
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Copyright Page
Verso the title page, these two pages are the legal pages of the book.
What to include:
• Title, subtitle
• Author name
• Copyright year and holder
• Type of copyright notice 
• Copyright of sources used
• Cover, Editor and other direct contributor credits

• With an introduction by…
• Color illustrations by…
• Translated by...

• Disclaimer if applicable
• ISBN (include e-book, paperback and hardcover ISBN numbers if applicable)
• Publisher name, city, country
• Country of printing
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Copyright Page Example
TITLE OF BOOK 
Copyright © Author Name, YEAR 
  
For information contact:
(Address, website)
http://www.website.com

Book and Cover design by Designer
ISBN: 1234567890

First Edition: Month 2024
Printed at EPL Makerspace, Edmonton, Alberta, Canada

A good place to look at what you want to include on your copyright page is https://pagemaster.ca/what-to-include-in-your-books-
copyright-page/ or https://blog.reedsy.com/guide/parts-of-a-book/copyright-page/  

 
Include information such as:

• Type of copyright notice (reserving all rights/creative commons/public domain),
• Disclaimer,
• Publisher (if you’re self-publishing the publisher is you),
• ISBN,
• Copyright of sources used (including, but not limited to: cover art, fonts, photographs, forwards, maps, illustrations, poems, lyrics, excerpts of 

copyrighted material),
• Place of printing,
• CIP/LCC Information 
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Reminder: 
Getting an ISBN 
can take up to 
three weeks so 
plan in advance. 
You request an 
ISBN though the 
Government of 
Canada website

• The International Standard Book 
Number (ISBN) is a globally 
recognized unique identification 
number required for the sale and 
distribution of a publication in 
Canada.

• In Canada, it’s free for self-
published authors and publishers 
who are Canadian residents to 
register an ISBN. 

• Apply for multiples if doing e-
book, hardcover, softcover, 
audiobook, etc.

ISBN

18



1. Acknowledgements
2. About the author
3. Appendix or addendum 
4. Chronology or timeline 
5. Endnotes
6. Glossary
7. Index
8. Copyright permissions (may also appear in the front 

matter in conjunction with the colophon page)
9. Discussion questions
10.Bibliography/reference list
11.Bonus material

Common Back Matter
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Formatting Manuscript
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Viewing Formatting
• Using the tools in your word processor 

will make it much simpler to prepare 
your book for print or digital 
distribution. 

• We will be using the Pilcrow (aka  
“Show/Hide button” or “backward P”) 
to reveal the various formatting 
features
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• Hitting the Show/Hide 
button allows the non-
printing characters to be 
revealed. 

• “Nonprinting characters” 
is Word’s term for 
anything that takes up 
space or has a formatting 
function but does not 
appear on the printed 
page, including spaces, 
tabs, page or paragraph 
breaks, etc.

Viewing Formatting
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Enter

Shift + Enter



Viewing 
Formatting
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Page Breaks
• Do not press Enter 

repeatedly to get to a new 
page – instead Insert a 
Page Break to start your 
text on a new page.

• You should use this for the 
start of new chapters or 
poems, or to insert blank 
pages.

• Page Break pushes any 
information after that page 
break onto the next page.
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• Page Break pushes any information 
after that page break onto the next 
page.

• Is great for adding blank pages.
• Section Break Next Page also pushes to 

next page AND splits your document 
into different parts to allow you to apply 
complex formatting.

Page Breaks vs Sections
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Using Sections
• One reason we want Sections in a 

document is to have specific parts of the 
book with different headers & footers.

• For example, if each chapter is a new 
section, we can have the individual 
Chapter Titles across the top of the 
page.
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• One reason we 
want Sections in 
a document is to 
have specific 
parts of the 
book with 
different 
headers & 
footers.
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Page break just stops 
the page and starts a 
new one and continues 
same formatting all 
through. Section break 
starts a new page but 
also makes it so 
formatting you do are 
changed going forward
https://www.youtube.co
m/watch?v=Q7-
gDV0RiCM



• Creating a Style 
(or Modifying an 
existing one) can 
allow you to edit 
your spacing, 
indentation, font, 
in one place.

• Keeps your book 
block CONSISTENT!

Styles
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• Styles ensure 
consistency by defining 
the appearance of text 
elements throughout 
your document.

• Allows for quick 
changes throughout 
your document – for 
both font and formatting.

• Using Heading Style 
easily creates Table of 
Contents 

Styles
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Fonts
• Serif fonts have decorative lines or tapers 

(also commonly referred to as “tails” or 
“feet”) while sans serif fonts don't—hence 
the “sans” in their title.

• Serif fonts are easier to read in printed 
materials but on small screens, are harder 
to read, especially if they have low 
resolution.
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Fonts
• The standard book font is the one that is 

used to type the main body text.
• For headings, you can choose a different 

font; a complementary sans-serif font or a 
bolder version of the serif font used for 
the body text.

• Not all fonts are free to print with when 
you are selling your work! You may need 
to research your specific font.
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• Free fonts to print: 
https://www.fontsquirrel.com/faq

• Noto fonts are intended to be visually harmonious across multiple 
languages, with compatible heights and stroke thicknesses. Noto Sans & 
Noto Serif
Copyright 2012 Google Inc. All Rights Reserved. This Font Software is licensed 
under the SIL Open Font License, Version 1.1

• DejaVu fonts are a font family whose purpose is to provide a wider range 
of characters.
Fonts are (c) Bitstream (see below). DejaVu changes are in public domain. 
Glyphs imported from Arev fonts are (c) Tavmjong Bah (see below). Copyright 
(c) 2003 by Bitstream, Inc. All Rights Reserved. Bitstream Vera is a trademark 
of Bitstream, Inc. Copyright (c) 2006 by Tavmjong Bah. All Rights Reserved.

• Monstserrat Inspired by the old posters and signs in the traditional 
Montserrat neighborhood of Buenos Aires. 
Copyright 2011 The Montserrat Project Authors 
(https://github.com/JulietaUla/Montserrat)

Fonts
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Arial
Baskerville
Book Antiqua
Bookman Old Style
Century
Courier
Garamond
Palatino
Sabon
Tahoma
Times New Roman
Veranda

Fonts
Common or standard fonts include:
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REMINDER:
Not all fonts are free to print with 
when you are selling your work! 
You may need to research your 

specific font.



• Font size is typically 
around 12pt.

• Chapter headings 
can be bigger, 
averaging 14pt –
20pt.

Font
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Alignment, Indentation, Spacing
Typically:
• Novels are Single Spaced
• Alignment is Justified
• The first paragraph of the chapter or 

after a scene break will not be indented
• The first lines of every other paragraph 

are indented (0.3” or .76 cm)
• There is no spacing before or after each 

paragraph
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Alignment, Indentation, Spacing

• BUT, you can play 
with design too!

• In some templates 
line spacing is set at 
Exactly at 15 pt or 
Multiple at 1.4.

• And poetry can really 
go wild.
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Alignment, Indentation, Spacing

• When using unique 
spacing make sure 
you are using the 
alignment and 
indenting options.
Don’t fall back on the 
space or tab bar.

• Select the Pilcrow to 
see the formatting.
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• Most chapters are 
aligned centered.

• Put a little bit of white 
space at the top of the 
page, or start chapters 
partway down the 
page.

• Use the Before and 
After spacing to 
achieve this.

Chapter Spacing
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Formatting Part 2
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Table of Contents
• The default Word Table of Contents rely 

on your use of styles and includes the 
first three heading levels.

• Click the References tab. Click Table of 
Contents, then Custom Table of Contents.

• Click the Options button in the Table of 
Contents dialog box to map the styles you 
used to the ToC framework.
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Table of Contents
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Table of Contents
• After you’ve edited your document, page 

numbers and headings may change; to 
update your Table of Contents, right-click 
in the table and choose Update Field, or 
choose Update Table.
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• Page Break pushes any information 
after that page break onto the next 
page.

• Is great for adding blank pages.
• Section Break Next Page also pushes to 

next page AND splits your document 
into different parts to allow you to apply 
complex formatting.

Page Breaks vs Sections
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Using Sections
• One reason we want Sections in a 

document is to have specific parts of the 
book with different headers & footers.

• For example, if each chapter is a new 
section, we can have the individual 
Chapter Titles across the top of the 
page.

https://www.youtube.com/watch?v=Q7-gDV0RiCM
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• Typically aligned 
centered or to the 
outside of the page 
(even page left, odd page 
right).

• First pages in a chapter 
may not have page 
numbers at all.

• Front Matter is either not 
numbered or uses roman 
numerals.

Page Numbers
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• If you want the front 
matter to have 
different number 
formatting you'll need 
sections

• Sometimes adding page 
numbers can be tricky, 
so always start at 
the beginning and work 
your way through 
the document

Page Numbers
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•A running head is a heading printed at the 
top of each page of a document or book.

•Usually this is either Author/Title or Book 
Title/Chapter Title where there is one of 
these elements at the top alternating odd 
and even pages.

Running Heads
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Photos & Artwork
Some photos require permission to use!
If you are using photos with people in them for advertising you need 
their permission. People have the right to profit from their photograph 
or likeness and this right continues after death and is given to their 
heirs.
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https://selfpublishingmadeeasy.wordpress.com/2013/02/11/
guidelines-on-using-photos-in-your-self-published-book 

Do I need permission to use this photo in my book?
A picture you took of a 
group or individual

On your cover 
(advertising purpose)

Yes

Inside your book
(editorial purpose)

Not necessarily

Public domain photos On cover or in your 
book

Not necessarily BUT
May need to credit



Images
• Any images inside the book should 

be a minimum of 300 DPI for 
printing.

• It is recommended to add images as 
the last stage of your book writing, 
and tweak images from front to 
back of your book.
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Low to high resolution



Images
• When you set an object's text wrapping to be in 

line with text, Word treats the object in question 
as a text character. 

• "Move Object With Text" setting determines 
whether the object will move with the paragraph 
to which it's anchored. 

• While the object is anchored to a paragraph, 
Word will move the object along with the 
paragraph. You can add or delete paragraphs 
above the one containing your object and the 
object moves along with its own paragraph.
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https://www.howtogeek.com/363208/how-to-position-images-in-a-word-document/



Different Wrap Text 
options control how the text 
and picture interact with one 
another.

Images
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https://www.techrepublic.com/article/how-to-use-the-many-text-wrapping-options-in-microsoft-word/

Through

Square

Tight



Add images in 
the headings in 
order to create 
embellished 
chapter titles.

Images
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Next Class: Cover Class in InDesign!
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Register for the Book Binding –
Cover Class class to learn how 
to design a cover spread for 
your book!

Bring:
• An idea for your cover spread
• Images/Artwork/Font you want 

to use on a usb
• Text you want to include on 

your cover
• ISBN Barcode (if selling)



File Submission
• Must submit book block and cover 

together (both should be PDF/A)
• Submissions for your book must 

happen during Fab Lab Hours so you 
can pre-pay for your book and get 
registered for Bookbinding – Binding 
Class
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How to make it PDF/A 
• Keep a copy in an editable form (word, google doc, etc). 
• Export completed file to PDF/A! 

File > Export > Options > PDF/A Compliant



• Reedsy – online service that can help format books (free & paid), as well as 
a Marketplace editing, design, and marketing (paid)

• How To Make A Book From An AO3 Page by ArmoredSuperHeavy

• LinkedIn Learning – Adobe InDesign Designing a Book (free with EPL card)

• Pagemasters – Edmonton company that prints independently published 
books; Editorial Review, Copy Edit, Proof-reading, Design & more services (paid)

• No Story Lost – memoir books written for you (they interview, record stories, 
transcribe the audio to text, and then write the book)

• Priority Printing – Edmonton company that prints independently published 
books; Full Design & Format Typesetting services (paid)

• Draft2Digital– online service that prints on demand; as well as having book 
formatting templates

Other Resources
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